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Introduction
Data from M-Bus meters connected to our smart Ethernet converters can be directly linked into, logged and 
processed in Microsoft® Excel®. No additional software or macro is required to open or format the CSV exports 
from the converters. We offer a simple Excel® spreadsheet file named JC-E_readout_<version>_EN.xlsm which 
fulfils basic functions of a readout application.

Supported are Microsoft Office® versions 2007 and higher. The source code of all macros is provided under the 
GPL license. It can be modified without any limitations and used for free even for commercial purposes.

In order to use this form of readout the converters must be set to the Smart M-Bus application mode. The Web 
Interface a Telnet manuals for our converters contain details on how to set this mode.

Usage and settings description
Steps for linking the converter exports to the xls file

Config sheet

Add converter links
Fill in Converter
names and
IP addresses

1.
Config sheet

Press Link Action
Empty cell or Add link 
action will create
Import & Log sheets

2.
Import sheets

Configure logging
Fill in log options

3.
Config sheet

Press Link Action
Init log action
verifies log options
creates log headers

4.

Collecting meter data	 Filtering the logged meter data

Config sheet

Collect data
Use manual or auto 
refresh to obtain 
meter data

5.
Data sheet

Press Available meters
Gathers available 
meters and options to 
filter their log data

6.
Data sheet

Set data filter
Choose which log 
data should be 
filtered out

7.
Data sheet

Press Graph
Filter out the logged 
data for the desired 
time period

8.

Important notes

See page 9.
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Linking the converters to the xls file
When opening the file it is necessary to enable macros and data connections (if CSV imports were already linked).

All that is needed to add the converters initially is to fill out the Converter addresses (1), Converter names (2), 
leave the Link action (3) cells empty and press the Link action button (4). The next step should be configuring 
the Log and meter names settings in the newly created sheets with the CSV imports.

Config sheet with the main settings.

1 - Converter address column
Converter IP addresses are entered into this column, these provide the links for the data imports. It is 
possible to enter any number of links. The first link must be directly under the caption and there must be 
no empty rows between links.

2 - Converter name column
Is the name of the CSV import sheet and the log sheet with added _log suffix. Automatically generated 
names will be used for converter names which were not filled in. These names must not be changed 
manually after linking. It is necessary to use an action in Link action (4) column.

3 - Link action column
This column determines what action will the Link action (4) button perform. An empty cell has the same 
meaning as the Add link action. Actions can be chosen from the dropdown menu available in this column.
Available actions are:
▪	 No change	 -	 The final state after setting up the log options. The action performed by the Link Action 

button will skip rows with this setting.

▪	 Add link	 -	Creates the data link. Adds new sheet with a data connection to the CSV export of 
the converter and a new log sheet. The names of the sheets are set according to the 
Converter name (3) column.

▪	 Change link	 -	Change the IP address of the data link. The CSV import and log sheets will not be 
removed. Log settings will be retained.

▪	 Delete link	 -	Removal of the linking. CSV import and log sheets will be removed.

▪	 Init log	 -	 Formats the header of the log sheet according to the log setting on the CSV import 
sheet. This option is automatically set after successful linking action. The settings on 
the CSV import sheet determine what will be logged and must be properly configured 
to collect the meter data.
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▪	 Init & clean log	 -	 Same as Init log with added clearing of all data on the log sheet.

Warning:	 This action does not require any user confirmation.
The data will be erased without notification.

4 - Link action button
Performs all actions set in the Link action (3) column.

Note:	 The Status column is filled out automatically. Depends on action performed on the link.

Log and meter names settings
The log options are located on individual CSV import sheets. Logging for each converter needs to be set up 
individually, however the configuration can be easily copied.

The configuration on the CSV import sheet applies to the log sheet with the same name with a _log suffix.

1 - Meter name column
Meter names can be entered into this column. This information is not part of the CSV import. Similar to 
the log settings this is just internal data of this XLS file. Names of all meters can be changed globally on the 
NamesManager - meter names management sheet.

	 A	-	Meter Info section
Basic meter information log settings section. Rows represent the columns from the first part of the CSV 
import. This section does not divide logging for each individual meter. For example enabling the logging of 
the Meter status will log status of all available meters.

2 - Log
Log enabling and simultaneously the column number in the log sheet.
Logging of the given item will be disabled if the cell is left empty or will contain the text no log. This 
option can also be selected from the dropdown menu.

To enable logging a cell must contain the text log + n. Where n is the number of the column in the log sheet.

Column log1 is the first column after the mandatory log data (Date and time, Log status and Meter ID), 
which means the fourth column in the log sheet.

Warning:	 Log column numbers must not repeat within the same Meter ID.
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Log sheet with initiated log settings.

3 - Log name
This is where a column title for the log sheet can be entered. If no name is provided and logging is 
enabled the title will be filled in automatically according to the Info name (4) column.

4 - Info name
This is an information column. It contains title copies of all the items which can be logged from the first 
part of the CSV import.

	 B	-	Value logging section
Meter values logging section. Individual values from each meter can be set for logging here. The log 
configuration uses a special setting method resilient to meter malfunctions and dropouts when the CSV 
import will not contain data from the inaccessible meters.

5 - Log
Same as point 2 - Log.

6 - Log name
This is where a column title for the log sheet can be entered. If no name is provided and logging is 
enabled the title will be automatically obtained according to the Meter_id (8) and Value line (7) from 
the CSV import column under the Value name (10) title. Explanation in next points.

7 - Value line
Line is a row of a single meter. Line number 1 means the first row of a new meter ID in the second part of 
the CSV import (9). Each new meter ID has a line number 1, following with 2, 3 ,4 etc. until a new meter 
ID or end of the CSV import occurs.

8 - Meter_id
Meter ID. Equates to meter_id in the second part of the CSV import (9).

Note:	 The log settings are just ordinary cells and can be copied using a multi-cell selection. Multiple cells can 
be selected and copy pasted into the desired place. It is also possible to edit or copy the settings into 
multiple sheets at once. Multi-sheet editing can be performed by selecting all the desired log sheets by 
holding the Ctrl key + clicking on the desired log sheet tabs at the bottom.

The following pictures demonstrate how a log configuration is set up.
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Import sheet

Principle of Value line configuration.

log7log6log5log4log3log2log1First 3 colums are always filled

Log sheet

Import sheet

Principle of log column configuration.
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NamesManager - meter names management

1 - Available meters button
This button needs to be pressed first. It will create a list of currently available meters. Meter details including 
meter names are obtained from the CSV import sheets.

2 - Meter name column
The current meter names are displayed in this column. It also allows setting the meter names. The desired 
name can be just entered to the appropriate cell and the change is stored by pressing the Set meter names 
(3) button.

3 - Set meter names button
Writes all meter names from the Meter name (2) column into the appropriate CSV Import sheets.

Automatic and manual data refresh

1 - There are two modes of automatic data refresh to choose from:
▪	Periodic refresh	 -	 This is a simple continuous repetition in a given time interval which will start 

immediately after checking the Auto refresh (3) checkbox.

The time interval is entered into the cell under the Period time label. The time is in 
minutes and is in the range of 1 to 2 147 483 647.

▪	Time based refresh	 -	 The data refresh will be performed every day at the entered time of day. It is 
possible to enter 1 to 4 points in time of a day during which the refresh will be 
performed. The time points can be entered in any order. A 24 hour time format is 
used (e.g. 13:00) where 0:00 is midnight.
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2 - Send readout command before refresh checkbox
This feature should not be normally used for auto refresh. It was designed for specific, not very common 
scenarios and to provide a remote Read now type of functionality found in the converter's Web Interface.

This command forces the converters to perform an immediate readout of the meters and thus retrieve 
the current values from the meters instead of the values collected by the converters during their internal 
readout cycles. The readout takes a while and depends on communication speed, number and type of 
meters and amount of data. It is necessary to wait for the finish of the readout so that the current values 
will be collected in the converters and be available for export. This wait time can be entered in the cell 
under the Refresh delay after readout label. The value is in minutes. The waiting time depends on the 
aforementioned factors and needs to be optimized for each individual application. The default setting is 10 
minutes.

The readout command will be sent to all connected converters. This will be followed by a delay which 
will take the entered amount of minutes after which the automatic data refresh (CSV import refresh) and 
logging will start.

It is possible to obtain the information about the finish of the meter readout from the converters however 
due to simplicity this functionality is not provided in this XLS macro.

3 - Automatic refresh checkbox
This checkbox turns on and off the automatic data refresh.
It is necessary to choose the refresh mode first and set the time or points in time. Also turning on the Send 
readout command before refresh (2) feature and setting the delay time must be performed before turning 
on the automatic refresh.

Warning:	 The automatic refresh must be turned off before changing any of its settings! It is possible to 
change the settings on the fly, however this is not recommended and the automatic refresh 
should be turned off before changing any of its settings.

4 - Refresh data now button
Manual data refresh. Performs data refresh from all converters and ads them to logs immediately after 
being pressed. Currently not bound to the Send readout command before refresh (2) feature.

Note:	 The cell under the label Next refresh label is an indicator of the next automatic data refresh time.

Data processing and filtering
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1 - Available meters button
Creates a list of available meters with log filtering options for each meter.

2 - Data options row
A list of all available columns from the log sheet will be created for each meter. Entering the text data + n 
or choosing it from the in-cell dropdown will select the appropriate log to be included as data source for 
processing or graph creation. Data will not be collected if the cell is left empty. The number n is the column 
number in the Data sheet. The log data will be collected into this column under the list of meters. The first  
column will contain the date and time of logging, data1 thus represents the second column on the sheet.

The cells in these rows can be copy pasted in order to duplicate the settings for all meters. The current 
implementation of filtering has its own meter selection so individual meters can have the same data filtering 
options or multiple meters can collect data into the same column since only one meter is always filtered.

Multiple log data from a single meter marked for collection into the same column will be overwritten. The 
data + n number must be chosen carefully to avoid this scenario.

3 - Graph button
This button opens the Graph data generator dialog. It performs the filtering of all the log data according to 
the options in the meter list and the time interval which is selected in step 2 of this dialog.

Graph data generator dialog.

4 - Converter dropdown
Allows to choose of converter i.e. log sheet from which to collect the log data.

5 - Meter dropdown
Allows to choose the meter on the selected converter.

6 - Next button
Log sheets data filtering will start by pressing this button. The program will go through the log sheet of the 
selected meter and will pick the values according to the options in the meter list on the Data sheet. The 
data will be collected for the entire log period. The choice of a specific time interval will then be available 
in the next step.

Filtering a large amount of data can take a while during which the dialog will show the message Filtering.... 
After a successfully finishing the filtering the dialog will be changed to the next step - choice of time interval.

If the data will be found, the initial time interval will be set to the entire available time interval from the first 
to the last found entry and the graph will be automatically refreshed to show this interval.

7 - Time interval start dropdown
The beginning of the time interval.

8 - Time interval end dropdown
The end of the time interval. The end date must not be before the start date.

9 - Update graph button
Changes the graph source data range. This action also redraws the graph using the new range.
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10 - Back button
Return to the previous step, choice of converter and meter. 

11 - Close button
Closes the dialog.

Possibilities of modifications and program changes
The entire program is divided into separate independent modules which do not need each other.
This enables replacement of entire modules such as data processing with your own macros without the need of 
modifying the import or logging code.
The core of the entire application is the ImportEngine module, Config sheet and FormProgress dialog. This 
forms the entire functionality of the linking management and logging operations. Meter names management: 
NamesManager module and NamesManager sheet. Log data filtering and graph creation: GraphEngine and 
FormGraphData dialog.

Advice on how to work with CSV exports
�� This program utilizes the data connection function with an external file. This functionality is available in 
Excel® on the Data tab in the Ribbon in the Get External Data group with the button From Text. The same 
tab also contains a Connections button which allows to view the currently linked data sources.

�� When a CSV file is opened using a normal file open method and Excel® does not recognize the data 
separator (;) and does not split the text into separate cells the Text to Columns button on the Data tab on 
the Ribbon can be used. This function also exist in VBA for use in macros.

Important notes
�� Very Important: Do not create any of your own custom worksheets after the Config sheet.
If you need additional worksheets add them before the Config sheet. The macro addresses the CSV import 
and log sheets by a numeric offset from the Config sheet and thus would fail to access the proper sheets if 
any were added after it manually by the user. 
Workheets can be added at the right-most last log sheet position only if no new links will be created, but it 
is still more preferable to place any custom sheets before the Config sheet.

�� Do not manually delete entire rows in the Config sheet. The macro looks for converter links starting from a 
fixed position on row 15.

�� Excel 2019® requires the option of All connected experiences to be turned on so that the CSV export 
can be reached. This option is usually turned on by default but it could be turned off in some business 
environments. To turn it on follow these steps: 
1. In the main ribbon choose File > Options.
2. In Excel Options choose Trust Center.
3. In Trust Center choose Privacy options.
4. On the Privacy options sub-screen click on the Privacy Settings... button.
5. In Privacy Settings dialog scroll down to All connected experiences.
6. Check the Turn on all connected experiences checkbox.
7. Click the OK button.
See picture below.
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Excel 2019® options Turn on all connected experiences.

Disclaimer
This program is provided as is, without any warranty.
We do not hold responsibility for:

I.	 Faults and failures of operation caused by incorrect use or change of source code.
II.	Errors in data and loss of data caused by bugs in the program, incorrect configuration or incorrect use.
III.	Functionality of the program with other then our own hardware.

You are taking full responsibility and risks associated with the use of this program. You are expressly agreeing 
that we do not bear any direct or indirect, accidental, personal or other forms of damage including loss of 
revenue, damage to reputation, damage to data or other material or immaterial losses which are related to the 
use of this program. The only means of compensation in case of your dissatisfaction is the discontinuation of 
the use of this program.

Microsoft®, Excel® and Microsoft Office® are registered trade marks of the Microsoft® corporation.


